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ABSTRAK 

Kebocoran daya pada bidang potong antena RLSA ¼ lingkaran menyebabkan nilai gain, bandwidth dan S1,1 

menurun, oleh karena itu hipotesis menambah penutup tembaga pada bidang potong antena RLSA ¼ lingkaran 

menjadi solusi saat ini untuk melihat pengaruhnya. Antena RLSA yang dirancang menggunakan software VBA 

macros yang disimulasikan pada CST Studio Suite 2018 dengan spesifikasi jari-jari 85 mm, P0 16, sudut 

beamsquint 71°. Penutupan bidang potong menggunakan 4 skenario yaitu dari jauh ke dekat feeder, dari tengah 

ke samping kiri dan kanan, dari dekat feeder menjauhi feeder dan penambahan cavity beserta dengan tembaga 

di area feeder. Penutupan tembaga yang bisa memberikan performansi yang baik berada pada letak posisi 

tembaga 0 – 7 mm diukur dari tepi lingkaran dengan nilai gain 11,80 dB dan pada posisi tembaga 38 – 47 mm 

diukur dari tepi lingkaran dengan nilai gain 11,91 dB, jadi ketika dikombinasikan pada posisi letak tembaga 

tersebut mendapatkan nilai gain 12 dB menguat 0,27 dB, bandwidth 1,279 GHz dan S1,1 -26,11 dB. Pada 

skenario III dan skenario IV tidak ada yang mendapatkan nilai gain lebih tinggi dari antena RLSA ¼ lingkaran 

tanpa penutup tembaga sehingga membuktikan bahwa panjang penutup tembaga yang mendekati feeder 

memiliki performansi yang tidak baik. 

 

Kata kunci: Bandwidth, gain, panjang penutup tembaga, RLSA ¼ lingkaran, S1,1. 
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ABSTRACT 

The power leakage in the quarter circle RLSA antenna cut plane causes the gain, bandwidth and S1.1 values 

to decrease, therefore the hypothesis of adding a copper cover to the quarter circle RLSA antenna cut plane is 

the current solution to see its effect. The RLSA antenna designed using VBA macros software is simulated on 

CST Studio Suite 2018 with a radius of 85 mm, P0 16, beamsquint angle of 71°. Closure of the cutting plane 

using 4 scenarios, namely from far to near the feeder, from the middle to the left and right sides, from near the 

feeder away from the feeder and adding a cavity along with copper in the feeder area. The copper cover that 

can provide good performance is in the copper position 0 – 7 mm measured from the edge of the circle with a 

gain value of 11.80 dB and at the copper position 38 – 47 mm measured from the edge of the circle with a gain 

value of 11.91 dB, so when combined with the copper position, the gain value is 12 dB, 0.27 dB, bandwidth 

1.279 GHz and S1.1 -26.11 dB. In scenario III and scenario IV, no gain value is higher than the RLSA loop 

antenna without a copper cover, thus proving that the length of the copper cover that is close to the feeder has 

poor performance. 

 

Keywords: Bandwidth, gain, length of copper cover, RLSA circle, S1,1. 
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BAB I 

PENDAHULUAN 

1.1 Latar Belakang 

Saat ini perkembangan teknologi di dalam ilmu telekomunikasi berkembang sangat 

pesat. hal ini dibuktikan dengan banyaknya penelitian mengenai komunikasi nirkabel (tanpa 

kabel). salah satu yang sedang dikembangkan adalah antena Radial Line Slot Array (RLSA). 

Antena RLSA adalah antena rongga atau pandu gelombang yang berbentuk piringan. Antena 

ini pertama kali dikembangkan untuk penerima satelit sebagai pilihan selain menggunakan 

antena parabola. tidak seperti antena parabola, antena RLSA memiliki keunggulan yaitu 

feeder yang ada di bagian belakang antena sehingga feeder tidak memblokir sinyal yang 

masuk. Keunggulan lainnya adalah bentuknya yang rata sehingga lebih estetis [1] serta 

memiliki gain tinggi dan efisiensi tinggi [2], [3]. Antena RLSA awalnya berukuran besar 

tidak kurang dari 600 mm [2], [4], jadi karena keunggulannya kini para peneliti lebih 

memfokuskan pada desain versi yang lebih kecil seperti gelombang milimeter [5], satelit 

bergerak [6], dan jaringan wireless local area network (WLAN) [7]–[9]. 

Namun, selama bertahun-tahun, pengembangan antena RLSA kecil telah mengalami 

masalah koefisien refleksi yang tinggi karena jumlah slot yang tidak mencukupi [10]. 

Beberapa penelitian telah dilakukan untuk mengatasi masalah ini. Misalnya, pada tahun 

1990, Hirokawa [11] memperkenalkan teknik slot yang cocok untuk membuang daya yang 

tersisa di perimeter RLSA kecil untuk mengurangi pantulan. Pada tahun 1998, Akiyama [12] 

menggunakan teknik slot yang cocok untuk membuang daya yang tersisa di perimeter antena 

RLSA untuk mengurangi refleksi. Namun, metode ini diyakini tanpa kontribusi pada 

peningkatan gain antena. Penelitian pada teknologi WLAN terus dikembangkan. pada tahun 

2004, Zagriatski [8] menggunakan teknik slot panjang untuk memaksimalkan radiasi daya 

melalui slot untuk mengurangi refleksinya dari perimeter antena RLSA. Namun, metode ini 

juga setelah diamati memiliki kemampuan untuk mengurangi gain sekaligus mengurangi 

koefisien refleksi terutama karena ketidakmampuannya untuk memancarkan daya dengan 

fokus. Pada tahun 2008, Ul Islam membangun antena RLSA menggunakan Flame Retardant 

4 (FR4) sebagai bahan cavity [13]. Antena ini berhasil digunakan di jembatan Universiti 

Teknologi Malaysia dengan jari-jari 75 mm, namun menghasilkan gain rendah 8 dB dan 

bandwidth yang sempit 75 MHz karena terdapat cacat setelah diamati selama proses 
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konstruksi seperti slot yang tumpang tindih dan perekatan yang kurang baik menyebabkan 

loss beberapa lapisan papan FR4.  

Pada tahun 2008, Imran berhasil mengembangkan antena RLSA dengan gain  26 dB 

untuk diimplementasikan pada router Wi-Fi point-to-point [14]. Perancangan ini 

menggunakan teknik beamsquint dan ini diamati mirip dengan apa yang digunakan untuk 

merancang antena RLSA pada aplikasi satelit. Oleh sebab itu diameter antena ini 600 mm 

masih terlalu besar untuk diaplikasikan pada teknologi Wi-Fi. Studi lain pada tahun 2012 

oleh T. Purnamirza peneliti yang berasal dari Indonesia menggunakan  tiga lapisan cavity 

termasuk 1 polypropylene dan 2 lapisan FR-4 untuk memungkinkan daya pantul menghilang 

sendiri [15]. Namun ternyata fabrikasi lebih rumit karena kebutuhan untuk menyelaraskan 

tiga lapisan dengan presisi tinggi. Sehingga dalam studi lainnya T. Purnamirza 

memperkenalkan teknik extreme beamsquint  agar slot memancarkan daya secara efisien 

yang secara signifikan mengurangi refleksi daya [10]. Selain itu penelitian tersebut juga 

menghasilkan program Visual Basic Application (VBA) yang dapat dimasukkan pada 

macros di dalam aplikasi CST Studio Suite, sehingga sangat berguna untuk merancang 

antena RLSA dengan mudah, akurat dan cepat. Hal ini juga menyebabkan keberhasilan 

pengembangan teknik ini untuk merancang beberapa antena RLSA kecil untuk kebutuhan 

pasar [16]–[20]. 

Setelah berhasilnya teknik extreme beamsquint yang menyebabkan slot pada antena 

RLSA tidak lagi berbentuk spiral. Hal ini menjadikan dilakukannya pengembangan teknik 

yang bernama teknik pemotongan. Teknik ini dapat memotong antena RLSA menjadi 

beberapa bagian tanpa banyak mengurangi performansi antena RLSA, tetapi menjadikan 

antena ini lebih kecil dan efisien dari antena RLSA yang berbentuk lingkaran penuh. 

Penelitian tersebut diawali oleh Zulfadli pada tahun 2016 [21] yang merancang antena RLSA 

½ lingkaran menggunakan teknik pemotongan pada frekuensi 5,8 GHz dengan hasil 

koefisien refleksi -11,34 dB, bandwidth 1,02 GHz dan gain 10,1 dB.  Pada tahun yang sama 

Firmansyah [22] membuat rancangan prototype antena RLSA ¼ lingkaran menggunakan 

frekuensi 5,8 GHz dengan hasil koefisien refleksi -17,94 dB, bandwidth 1,119 GHz dan gain 

9,85 dB, Serta pada tahun 2017 [23] penelitian yang dilakukan oleh M. Soleh berhasil 

membuat prototype pada antena RLSA ¼ lingkaran menggunakan frekuensi 5,8 GHz 

menjadi antena point-to-point yaitu Wi-Fi bridge wireless yang berjalan cukup baik serta 

dengan hasil performansi yang lebih baik dari penelitian sebelumnya dengan hasil koefisien 

refleksi -23,69 dB, bandwidth 1,232 GHz dan gain 11,73 dB. 
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 Penulis tertarik dengan teknik pemotongan pada antena RLSA ¼ lingkaran karena 

antena ini memiliki ukuran yang kecil namun performansinya masih cukup baik jika 

dibandingkan dengan antena RLSA penuh, dapat dilihat pada penelitian [24] peneliti 

mengharapkan RLSA ¼ lingkaran memiliki gain 6 dB atau empat kali lebih rendah daripada 

RLSA penuh sebagai konsekuensi dari pengurangan ukuran empat kali lipat. Ternyata, kami 

mengamati bahwa rata-rata RLSA ¼ lingkaran memiliki gain sekitar 1 dB lebih rendah 

daripada RLSA penuh. Perbedaan kecil yang tidak terduga ini disebabkan oleh kepadatan 

daya yang lebih tinggi pada RLSA ¼ lingkaran. Sebenarnya antena RLSA ¼ lingkaran ini 

sudah dikembangkan lagi dan berhasil menjadi antena RLSA dual beam ¼ lingkaran [25] 

dan antena RLSA dual band ¼ lingkaran [26], namun karena masih ada masalah pada teknik 

pemotongan, kebocoran daya terjadi pada sepanjang sisi bidang potong pada antena RLSA 

¼ lingkaran ini yang menyebabkan sebagian daya keluar dari bagian bidang potong antena 

RLSA ¼ lingkaran. Oleh sebab itu perlu dilakukan penelitian lebih lanjut karena pasti ada 

pengaruh apabila dilakukan penambahan penutup menggunakan bahan yang sama dengan 

bagian dielektrik dan background yaitu tembaga. Dengan melakukan analisis kelipatan 

panjang penutup tembaga pada bagian bidang potong antena RLSA ¼ lingkaran, maka dapat 

menjadi rekomendasi penulis untuk melakukan penelitian ini dengan judul “Analisis 

Pengaruh Penambahan Penutup Tembaga Pada Bidang Potong Antena Radial Line 

Slot Array ¼ Lingkaran”.  

1.2 Rumusan Masalah 

Merujuk pada latar belakang, penelitian ini memiliki rumusan yaitu terjadinya 

kebocoran daya pada bidang potong antena RLSA ¼ lingkaran menyebabkan penurunan 

performansi meliputi koefisien refleksi (S1,1), bandwidth dan gain, sehingga diperlukan 

penutupan menggunakan tembaga pada bidang potong antena RLSA ¼ lingkaran untuk 

mengurangi efek kebocoran daya tersebut.  

1.3 Tujuan Penelitian 

Merujuk pada rumusan masalah, tujuan dari penelitian ini adalah mengetahui panjang 

penambahan penutup tembaga yang dibutuhkan serta analisis pengaruh penambahan 

penutup tembaga pada bidang potong antena RLSA ¼ lingkaran yang mempengaruhi 

performansi antena RLSA meliputi koefisien refleksi (S1,1), bandwidth dan gain. 
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1.4 Batasan Masalah 

Penelitian ini memiliki batasan masalah sebagai berikut: 

1. Frekuensi yang digunakan pada frekuensi 5,8 GHz. 

2. Perancangan menggunakan aplikasi CST Studio Suite. 

3. Antena yang digunakan merujuk pada penelitian antena RLSA ¼ lingkaran 

sebelumnya[23]. 

4. Penelitian perancangan antena ini terbatas hanya pada rancangan simulasi. 

1.5 Manfaat Penelitian 

Penambahan penutup menggunakan tembaga pada bidang potong antena RLSA ¼ 

lingkaran akan mengetahui pengaruhnya dan memberikan performansi yang lebih baik 

meliputi koefisien refleksi (S1,1), bandwidth dan gain dibandingkan dengan antena RLSA 

¼ lingkaran tanpa penambahan penutup tembaga pada bidang potong antena RLSA ¼ 

lingkaran. 
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BAB II 

TINJAUAN PUSTAKA 

2.1 Penelitian Terkait 

Sampai saat ini perkembangan antena RLSA pada frekuensi 5,8 GHz sudah sampai 

pada teknik hybrid yang merupakan perpaduan antara teknik extreme beamsquint dan teknik 

pemotongan yang sudah terbukti menghasilkan performansi yang baik pada koefisien 

refleksi, bandwidth dan gain, sehingga peneliti akan menjawab pengaruh dari kebocoran 

daya yang terjadi  pada jurnal [24][23]. 

 

Tabel 2.1 Literatur review simulasi penelitian terkait 

No Judul Spesifikasi Gain Bandwidth S1,1 

[21] 

Pembuatan Prototype 

Antena RLSA untuk 

Verifikasi Hasil Simulasi 

Teknik Pemotongan ½ 

Antena RLSA pada 

Frekuensi 5,8 GHz (2016) 

Jari-jari 75 

dan tau 78 
10,1 dB 1,020 GHz -11,34 dB 

[22] 

Rancang Bangun 

Prototype Antena Radial 

Line Slot Array (RLSA) 

dengan Teknik 

Pemotongan 1/4 untuk 

Frekuensi 5,8 GHz (2016) 

Jari-jari 75, 

P0 16 dan tau 

89 

9,85 dB 1,119 GHz -17,94 dB 

[25] 

Rancang Bangun 

Prototype Antena Radial 

Line Slot Array (RLSA) 

dengan Teknik 

Pemotongan ¼ Lingkaran 

Dan Teknik Pembagian 

Dual Beam pada 

Frekuensi 5,8 GHz (2017) 

Jari-jari 85, 

P0 16 dan tau 

73 

7,92 dB 1,125 GHz -15,50 dB 

[24] 

Cutting Technique for 

Constructing Small Radial 

Line Slot Array Antennas 

(2021)  

Jari-jari 75, 

P0 10, 12, 14 

dan 16 dan 

tau 75-89      

8,1 dB 1,0 GHz  -20 dB  
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Tabel 2.1 Literatur Review (Lanjutan) 

[23] 

A New Size 

Reduction Method 

for Radial Line Slot 

Array (RLSA) 

Antennas (2020) 

Jari-jari 85, 

P0 16 dan tau 

71 

11,73 dB 1,232 GHz -23,69 dB 

 

2.2 Antena RLSA 

Antena Radial Line Slot Array adalah sebuah antena directional yang berbentuk 

piringan yang memiliki feeder di tengahnya sebagai saluran transmisi dan pasangan slot 

antena di bagian dielektrik yang tersusun saling berhubungan dengan struktur yang teratur 

agar menciptakan pola radiasi tertentu. 

Antena RLSA terdiri dari material yang sudah diperjualbelikan di pasaran, dengan 

menggunakan material yang sudah banyak dipakai pada penelitian antena RLSA 

sebelumnya. Material antena RLSA ¼ lingkaran dapat dilihat pada gambar 2.1 berikut. 

 

 
 

(a)               (b) 

Gambar 2.1 (a) Material dasar antena RLSA (b) Feeder antena RLSA 

 

1. Elemen Pemancar (Radiating element) 

Radiating element berfungsi sebagai dielektrik untuk memancarkan pola pancaran 

daya. 

2. Rongga (Cavity) berfungsi sebagai penyebar sinyal menuju pasangan slot untuk 

mengeluarkan pola radiasi pada beamsquint tertentu. 
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3. Background berfungsi sebagai reflektor agar sinyal tidak keluar pada bagian yang 

tidak diinginkan. 

4. Pengumpan (Feeder) berfungsi sebagai penyalur aliran listrik yang diubah menjadi 

sinyal elektromagnetik. 

 

Tabel 2.2 Material antena RLSA 

Material Jenis 

Radiating element Tembaga 

Background Tembaga 

Cavity Polypropylene 

Feeder Tembaga 

Tipe feeder SMA 

 

2.2.1 Prinsip Kerja Antena RLSA 

Radiating element berfungsi sebagai peraturan susunan pasangan slot yang telah 

dirancang sehingga menghasilkan pola radiasi yang baik. pada saat daya masuk ke antena 

melalui feeder, daya tersebut akan dipancarkan melalui lubang-lubang pasangan slot yang 

sudah diatur pada radiating element. Pasangan slot yang berada paling dekat dengan feeder 

maka akan meradiasikan daya paling besar, sedangkan pasangan slot yang semakin jauh dari 

feeder maka akan meradiasikan daya semakin kecil.  

Sistem propagasi antena RLSA ada 2 Tahap yaitu TEM coaxial mode dan TEM 

cavity mode. Pada gambar 2.2 sinyal disimbolkan dalam bentuk arah panah, sinyal masuk 

melalui feeder yang menggunakan jenis Subminiature Version A (SMA) yang dimodifikasi 

dengan  menambahkan head disc, pada saat ini arah panah berada dalam TEM coaxial mode 

yang kemudian akan diubah menjadi TEM cavity mode saat berada di head disk sehingga 

sinyal yang disalurkan oleh feeder akan merambat dengan arah radial pada bagian cavity, 

maka sinyal tersebut akan dipancarkan melalui banyak pasangan slot pada radiating element 

sehingga menjadi sinyal gelombang elektromagnetik dengan arah beamsquint tertentu yang 

karena jenis antena ini adalah antena directional [27]. 
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Gambar 2.2 Sistem kerja antena RLSA 

2.2.2 Peraturan Desain Slot Antena RLSA ¼ Lingkaran 

Radiating element merupakan tempat untuk penempatan slot antena Radial Line Slot 

Array, slot akan berpasangan dan tersusun secara array serta berjumlah banyak untuk 

menghasilkan kualitas sinyal yang baik. Pasangan slot diatur dengan peraturan dari teori 

yang dikembangkan oleh T. Purnamirza [27] untuk menghindari terjadinya interferensi dan 

overlapping, oleh karena itu dibutuhkan rumus persamaan dalam mendesain slot antena 

RLSA ini. 

Dari keterangan parameter simbol slot antena RLSA ini, selanjutnya merupakan 

pengaturan slot antena RLSA dengan persamaan-persamaan sebagai berikut:  

 

Gambar 2.3 Penempatan posisi slot antena RLSA 

 

𝜃1 =
π

4
+

1

2
{𝑎𝑟𝑐𝑡𝑎𝑛 (

𝑐𝑜𝑠(𝜃𝑇)

𝑡𝑎𝑛(𝜙𝑇)
) − (𝜙 − 𝜙𝑇)} (2.1) 

𝜃2 =
3π

4
+

1

2
{𝑎𝑟𝑐𝑡𝑎𝑛 (

𝑐𝑜𝑠(𝜃𝑇)

𝑡𝑎𝑛(𝜙𝑇)
) − (𝜙 − 𝜙𝑇)} (2.2) 

Keterangan: 

𝜃1 : Sudut kemiringan slot 1 

𝜃2 : Sudut kemiringan slot 2  
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𝜃𝑇 : Sudut beamsquint pada arah elevasi 

𝜙 : Sudut azimuth dari posisi slot 1 dan slot 2 

𝜙𝑇 : Sudut beamsquint pada arah azimuth 

 

Pasang-pasangan slot pada dielektrik radiating element dapat disebut juga sebagai 

unit radiator, unit radiator harus dihitung dengan akurat agar tidak mengurangi kinerja antena 

yang akan dihasilkan. jarak unit radiator dari titik pusatnya dapat dilihat pada gambar 2.4 

dari persamaannya pada rumus 2.3 berikut. 

 

Gambar 2.4 Setelan geometri unit radiator 

 

Untuk mencapai hasil yang presisi dan akurat maka digunakan persamaan rumus berikut: 

ρρ =
𝑛𝜆𝑔

1 − 𝜉𝑠𝑖𝑛𝜃𝑇( 𝜙 − 𝜙𝑇)
 (2.3) 

Dimana 𝜉 =
1

√𝜀𝑟1

 

Keterangan: 

𝑛 : Jumlah pasangan slot di ring pertama 

𝜆𝑔 : Panjang gelombang 

𝜃𝑇 : Sudut beamsquint pada arah elevasi 

𝜙 : Sudut azimuth dari posisi slot 1 dan slot 2 

𝜙𝑇 : Sudut beamsquint pada arah azimuth 

𝜉 : Ksi 
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Gambar 2.5 Parameter slot antena RLSA 

 

Cara menghitung jarak antara dua unit radiator yang berdekatan pada ring yang berbeda 

(pada arah radial) dapat digunakan persamaan rumus berikut: 

𝑆ρ =
𝜆𝑔

1 −  𝜉𝑠𝑖𝑛𝜃𝑇( 𝜙 − 𝜙𝑇)
 (2.4) 

Cara menghitung jarak antara dua unit radiator yang berdekatan pada ring yang sama (pada 

arah azimuth) dapat digunakan persamaan rumus berikut: 

𝑆𝜙 =
2𝜋 𝜆𝑔

√1 − 𝜉2 sin𝜃𝑇
2

 
𝑞

𝑝
 

(2.5) 

Sehingga pada gambar 2.5 diatas dapat dirumuskan jarak dari slot 1 ke pusat antena dan 

jarak dari slot 2 ke pusat antena dengan persamaan berikut: 

𝜌1 =
(𝑛 − 1 + 𝑞 − 0.25)𝜆𝑔

1 − 𝜉𝑠𝑖𝑛𝜃𝑇𝑐𝑜𝑠(𝜙 − 𝜙𝑇)
 (2.6) 

𝜌2 =
(𝑛 − 1 + 𝑞 + 0.25)𝜆𝑔

1 − 𝜉𝑠𝑖𝑛𝜃𝑇𝑐𝑜𝑠(𝜙 − 𝜙𝑇)
 (2.7) 

Keterangan: 

𝜆𝑔 : Panjang gelombang 

𝜃𝑇 : Sudut beamsquint pada arah elevasi 

𝜙 : Sudut azimuth dari posisi slot 1 dan slot 2 

𝜙𝑇 : Sudut beamsquint pada arah azimuth 

ξ : Ksi 
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Pasangan slot agar tidak berdempetan makan digunakan persamaan rumus berikut: 

𝐿𝑟𝑎𝑑 = (4,9876 × 10−3 × 𝜌)
12,5 × 109

𝑓0
 (2.8)  

Keterangan: 

𝐿𝑟𝑎𝑑 : Jarak pasangan slot berdasarkan jari-jari 

𝜌 : Jarak slot 

𝑓0 : Frekuensi tengah 

2.3 Parameter Antena RLSA 

Parameter antena berfungsi untuk menganalisa apakah performansi antena sudah 

sesuai kebutuhan atau belum, Parameter antena sejatinya saling berkaitan satu sama dengan 

yang lainnya. Parameter antena meliputi pola radiasi, daerah medan, pengarahan 

(direktivitas), efisiensi antena, gain. beamwidth, bandwidth, impedansi antena, koefisien 

refleksi dan polarisasi antena. Namun beberapa parameter penting untuk menganalisa 

Antena RLSA adalah koefisien refleksi(s1,1), bandwidth, gain serta pola radiasi. 

2.3.1 Koefisien Refleksi (S1,1)   

 Koefisien refleksi adalah rasio amplitudo dari gelombang yang direfleksikan 

terhadap amplitudo gelombang yang dikirim melalui antena[27]. Koefisien refleksi bisa 

terjalin sebab terdapatnya mismatch dari saluran transmisi dengan impedansi masukan beban 

pada antena[10]. Koefisien refleksi bisa dihitung memakai persamaan rumus dibawah ini: 

Γ =
𝑍𝑖𝑛 − 𝑍0

𝑍𝑖𝑛 + 𝑍0
 (2.9) 

Secara logaritma dapat dihitung dengan: 

Γ[dB] = 20 log|Γ| (2.10) 

Keterangan: 

Γ   = Koefisien refleksi 

𝑍𝑖𝑛 = Impedansi beban 

𝑍0  = Impedansi saluran transmisi 

 

 Dalam perancangan antena, salah satu parameter yang menjadi acuan dalam 

menentukan kualitas kinerja suatu antena dapat dilihat dari nilai koefisien refleksi <-10 dB 

yang menyatakan telah matchingnya impedansi masukan dengan impedansi beban sehingga 

suatu antena dikatakan memiliki kinerja yang baik pada frekuensi kerjanya[27]. 
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2.3.2 Bandwidth 

Bandwidth adalah rentang frekuensi atau lebar pita dari spesifikasi frekuensi yang 

akan  digunakan pada antena tersebut[28].  

𝐵𝑊 =  𝑓𝑚𝑎𝑥 − 𝑓𝑚𝑖𝑛 (2.11) 

Keterangan: 

𝑓𝑚𝑎𝑥 = Frekuensi maksimal 

𝑓𝑚𝑖𝑛 = Frekuensi minimal 

2.3.3 Gain Antena 

Definisi daripada direktivitas antena serta gain antena secara esensialnya memiliki 

kesamaan kecuali pada bagian daya yang digunakan. 

Direktivitas [𝐷(𝜃, 𝜙)] adalah perbandingan antara densitas daya radiasi antena pada 

jarak titik tertentu terhadap daya radiasi total antena secara isotropik. Sedangkan gain 

[𝐺(𝜃, 𝜙)] adalah perbandingan densitas radiasi antena pada jarak titik tertentu terhadap daya 

input total antena yang diradiasikan secara isotropis.  

Hingga, gain antena bakal bergantung pada daya total yang melayani terminal 

masukan antena, dan perhitungan buat rugi-rugi ohmic pada antena dicoba ketika direktivitas 

bergantung pada daya total radiasi serta tidak terhitung dampak rugi-rugi ohmic. jadi 

persamaan rumus gain adalah sebagai berikut[28]: 

𝐺(𝜃, 𝜙) =  𝑒𝑐𝑑  𝐷(𝜃, 𝜙) 2.12) 

Maka gain dalam dB: 

𝐺(𝜃, 𝜑)[𝑑𝐵] = 10 𝑙𝑜𝑔10 𝐺(𝜃, 𝜙) 
(2.13) 

Keterangan: 

𝐺 = Gain 

𝐷 = Direktivitas 

2.3.4 Pola Radiasi 

Pola radiasi antena adalah suatu gambar biasanya dalam bentuk grafik yang 

melambangkan fitur radiasi antena yang berguna untuk posisi pada koordinat spheris 

(koordinat bola). Tipe–tipe universal pola radiasi antena berbentuk Pola daya yang 

menggambarkan normalisasi daya terhadap posisi koordinat spheris, serta pola medan yang 

menggambarkan normalisasi medan E serta H terhadap posisi koordinat spheris. 
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Macam-macam medan antena: 

a. Medan reaktif adalah bagian ciri medan antena akibat gelombang berdiri yang 

melambangkan daya yang tersimpan. 

b. Medan radiasi adalah bagian dari ciri medan antena akibat radiasi gelombang 

(propagasi) yang melambangkan daya dipancarkan oleh antena. 

Daerah medan antena: 

a. medan dekat reaktif adalah daerah yang terletak di sekitar antena dimana medan 

reaktif sangat dominan  

b. medan dekat radiasi atau daerah fresnel adalah daerah antara medan dekat reaktif 

serta medan jauh dimana radiasi medan sangat dominan serta distribusi medan 

bergantung jarak dari antena. 

c. medan jauh atau daerah fraunhofer adalah daerah yang paling penting serta sangat 

terjauh dari antena dimana distribusi medan secara esensial berdiri sendiri dari jarak 

antena sumber (propagasi gelombang).  

 

Definisi-definisi pola radiasi antena: 

a. Pola isotropik merupakan pola suatu antena didefinisikan selaku radiasi serba sama 

ke seluruh arah, pola ini dibangun oleh suatu radiator isotropik (sumber titik, suatu 

antena non-fisik yang tidak memiliki arah). 

b.  Pola keterarahan adalah suatu pola dikarakterisasi oleh sebagian radiasi yang efektif 

dalam satu arah dibanding arah yang lain (secara antena yang bisa direalisasikan 

merupakan antena pengarah saja). 

c. Pola omnidirectional adalah suatu pola yang serba sama dalam pemberian ruang 

radiasinya. 

d. Pola bidang utama merupakan pola bidang E serta bidang H dari suatu polarisasi 

linier antena. 

e. Bidang E merupakan bidang yang terdiri dari vektor medan listrik serta arah 

radiasinya maksimum. Bidang H merupakan bidang yang terdiri vektor medan 

magnetik serta arah radiasinya maksimum. 

 

Parameter–parameter pola antena: 

1. Kuping radiasi (Radiation lobe) adalah puncak keseriusan radiasi paling tinggi di 

sekitar wilayah keseriusan radiasi terendah. 
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2. Kuping Utama(Main lobe) adalah kuping radiasi pada arah radiasi maksimum. 

3. Kuping Minor (Minor lobe) adalah kuping radiasi yang lain daripada kuping utama. 

4. kuping Sisi (Side lobe) adalah suatu kuping radiasi dalam arah yang lain daripada 

arah radiasi yang dipusatkan. 

5. Kuping Belakang (Back lobe) adalah kebalikan daripada kuping radiasi terhadap 

kuping utama. 

6. Half Power Beamwidth (HPBW) adalah lebar sudut berkas utama pada titik separuh 

energi antena. 

7. First Null Beamwidth (FNBW) adalah lebar sudut antara bagian null (kosong) awal 

pada sisi lain berkas utama[28]. 

 

 

Gambar 2. 6 Parameter–parameter pada pola radiasi antena  

2.4 Teknik Pemotongan 

Slot antena RLSA biasanya terdistribusi secara merata di seluruh permukaan antena, 

seperti yang ditunjukkan pada gambar 2.7(a). Untuk memiliki refleksi rendah, jumlah slot 

yang cukup diperlukan untuk memancarkan daya. Oleh karena itu, slot harus sedekat 

mungkin. Antena RLSA ini menggunakan nilai beamsquint tinggi untuk merancang slot 

yang berdekatan. Hasil dari desain adalah area slot terkonsentrasi dan area kosong, seperti 

yang ditunjukkan pada gambar 2.7(b). Area kosong seharusnya tidak berkontribusi pada gain 

antena, karena tidak memiliki slot untuk memancarkan daya. Hipotesis penelitian 
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menunjukkan untuk memotong dan menghapus area kosong agar menghasilkan antena yang 

lebih kecil. gambar 2.7(c) dan (d) menggambarkan dua antena yang lebih kecil yang 

dihasilkan dari pemotongan ini. 

selanjutnya para peneliti mengasumsikan bahwa RLSA yang dipotong pada gambar 

2.7(c) dan (d) akan memiliki kerapatan daya di dalam cavity antena lebih tinggi daripada 

RLSA penuh pada gambar 2.7(b). Lebih khusus lagi, densitas daya harus sekitar dua kali 

lebih besar di setengah RLSA dan sekitar empat kali lebih besar di seperempat RLSA 

daripada di antena penuh. Peningkatan ini terjadi karena area perimeter seperempat dan 

setengah RLSA masing-masing dua kali dan empat kali lebih kecil daripada RLSA penuh. 

gambar 2.8 mengilustrasikan area perimeter antena. setelah diamati bahwa kerapatan daya 

RLSA penuh, RLSA seperempat, dan setengah RLSA masing-masing adalah P/2πRh, 

P/2πRh/4, dan P/2πRh/2[24]. 

 

Gambar 2.7 (a) Antena RLSA biasa (b) Antena RLSA dengan nilai beamsquint tinggi (c) 

Antena ½ RLSA (d) Antena ¼ RLSA 
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Gambar 2.8 Area perimeter dari (a) Antena RLSA penuh, (b) Antena ½ RLSA, (c) Antena 

¼ RLSA 

 

Kepadatan daya yang lebih tinggi akan mengurangi koefisien refleksi, memperlebar 

bandwidth, dan meningkatkan gain, karena lebih banyak daya yang akan keluar dari slot 

RLSA ini dibandingkan dengan slot RLSA penuh. Oleh karena itu, sisa daya yang lebih 

sedikit di perimeter antena akan dipantulkan kembali ke feeder dibandingkan dengan RLSA 

penuh, sehingga mengurangi koefisien refleksi.  

2.4.1 Efek Negatif Teknik Pemotongan 

Aliran daya dalam antena RLSA biasanya sempurna dalam arah radial seperti yang 

digambarkan pada gambar 2.9(a). Namun, beberapa efek negatif telah melekat pada 

pemotongan antena RLSA dan ini termasuk kebocoran daya di sepanjang garis pemotongan 

dan gangguan arah aliran daya di dalam antena seperti yang ditunjukkan pada gambar 2.9(b). 

Ini lebih lanjut mempengaruhi kinerja antena dalam hal gain, koefisien refleksi, dan pola 

radiasi [1], [27]. Kebocoran daya mengurangi gain dan mengganggu pola radiasi dengan 

keluar dari garis potong daripada slotnya. Koefisien refleksi, bagaimanapun berkurang 

ketika kebocoran daya pada perimeter antena dan garis potong terlepas. Selain itu, gangguan 

arah aliran daya juga mengurangi gain karena diperlukan arah radial yang sempurna untuk 

menghasilkan gain yang optimal[23]. 
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2.4.2 Efek Positif Teknik Pemotongan 

Beberapa efek positif dari pemotongan antena RLSA juga diamati selain 

pengurangan ukuran dan ini termasuk slot yang lebih padat dan kepadatan daya yang lebih 

tinggi [1], [27]. Gambar 2.7(a), (b), (c) dan (d) menunjukkan antena RLSA yang dipotong 

memiliki slot yang lebih padat daripada lingkaran penuh dan ini memiliki kemampuan untuk 

memancarkan lebih banyak daya untuk mengurangi daya pantul yang tersisa di perimeter 

antena, sehingga meningkatkan koefisien refleksi. Efek samping lain dari pemotongan 

adalah peningkatan densitas daya dan ini diamati kira-kira empat kali lebih banyak dalam 

seperempat potong daripada di RLSA lingkaran penuh. Ini terkait dengan aliran semua daya 

yang diluncurkan oleh feeder ke slot di seperempat potong tetapi, secara penuh, beberapa 

diamati mengalir ke area kosong tanpa kontribusi apa pun pada gain seperti yang 

ditunjukkan pada gambar. 2.9(a). Kepadatan daya yang lebih tinggi di seperempat potong 

juga diharapkan untuk meningkatkan koefisien refleksi dan memperluas bandwidth karena 

lebih banyak daya yang keluar dari slot dibandingkan dengan yang penuh[23].  

 

 

(a)                         (b) 

Gambar 2.9 Aliran daya di dalam (a) antena RLSA penuh (b) Antena ¼ RLSA 

 

Perfectly Radialy 

Power Flow 
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BAB III 

METODOLOGI PENELITIAN 

3.1 Jenis Penelitian 

Penelitian tugas akhir ini menggunakan Jenis penelitian kuantitatif menggunakan cara 

Simulasi, Parameterisasi, pengamatan secara kualitatif dan metode deskriptif dalam 

menyampaikan hasil penelitian. penelitian kuantitatif adalah metode penelitian yang 

spesifikasinya sistematis, terencana, terstruktur dengan jelas dan akurat, biasanya dinyatakan 

dalam bentuk angka, grafik, dan menggunakan rumus statistik dalam perhitungannya. 

Kemudian Metode deskriptif adalah metode yang digunakan untuk mendeskripsikan atau 

memberikan gambaran umum mengenai objek yang diteliti melalui data atau sampel yang 

telah dikumpulkan dari hasil program atau institusi terkait tanpa melakukan rekayasa. 

3.2 Diagram Alir Penelitian  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mulai 

Studi literatur 

Menyiapkan perangkat dan aplikasi 

Menentukan parameter antena RLSA ¼ 

lingkaran pada frekuensi 5,8 GHz 

Merancang dan mensimulasikan antena 

RLSA ¼ lingkaran pada CST Studio Suite  

Hasil data penambahan penutup tembaga 

dan tanpa penutup tembaga  

Skenario perancangan 
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3.2.1 Diagram Alir Perancangan 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Skenario I 

Data S1,1,  bandwidth dan gain pada 

Microsoft Excel dari  skenario I, II, III  

dan IV 

Selesai 

Skenario II Skenario III 

Input 

Xmin, Xmax 

Ymin, Ymax 

Zmin, Zmax 

P = Panjang penutup tembaga 

Mulai 

Skenario IV 

Selesai 

Analisa penambahan penutup tembaga dan tanpa penutup 

tembaga pada bagian bidang potong antena RLSA ¼ lingkaran 
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3.3 Studi Literatur 

Penulis mendapatkan rekomendasi penelitian dari pembimbing bahwa teknik 

pemotongan pada antena RLSA menyebabkan kebocoran daya pada bagian bidang potong 

antena RLSA ½, 1/3 dan ¼ lingkaran, oleh karena itu kami membuat hipotesis bahwa 

penambahan penutup tembaga akan membuat bidang potong tertutup dan akan memberikan 

pengaruh 1 arah yaitu negatif dan positif, dari teori yang sudah dilakukan sebelumnya 

menjadikan hipotesis penelitian ini semakin penting dilakukan untuk pengembangan antena 

RLSA di masa depan. 

3.4 Perangkat dan Aplikasi Penelitian  

Penelitian ini dilakukan dengan merancang dan mensimulasikan pada Personal 

Computer (PC). Spesifikasi yang digunakan haruslah mumpuni sehingga penulis 

merekomendasi menggunakan perangkat keras dan perangkat lunak yang dapat membuat 

antena RLSA dengan baik. 

3.4.1 Perangkat Keras 

1. Laptop Acer Aspire E1-432 

a. Intel Celeron 2955U (1,4 GHz, 2MB L3 cache) 

b. Intel HD Graphic 

c. 14,0” HD LED LCD 

d. RAM 4 GB DDR3 L Memory 

e. 500 GB HDD 

f. 256 GB SSD 

3.4.2 Perangkat Lunak 

1. Microsoft Windows 10 pro 

a. CST Studio Suite 2018 

 

Gambar 3.1 CST Studio Suite 2018 
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b. Software VBA dalam bentuk file RLSA_untuk_5,8_GHz.mcs dan 

Memotong_RLSA_untuk_5,8_GHz.mcs. 

c. Microsoft Excel 2019 

3.5 Parameter Antena RLSA ¼ Lingkaran 

Parameter antena RLSA ¼ lingkaran ini masih sama seperti penelitian sebelumnya 

yang menganalisis dengan mencoba mencari jari-jari antena, jumlah slot pada ring pertama 

dan beamsquint yang bagus terhadap performansi antena.  

Parameter yang digunakan pada penelitian ini mengacu pada penelitian Muhammad 

soleh yang terdapat pada jurnal [23], yaitu hasil penelitiannya menunjukkan parameter 

terbaik yaitu jari-jari antena RLSA 85 mm, Jumlah slot pada ring pertama 16 dan sudut 

beamsquint 71°, oleh karena itu penelitian ini akan menggunakan parameter tersebut. 

 

Tabel 3.1 Parameter desain antena RLSA ¼ lingkaran 

Simbol Parameter Nilai 

𝑓 Frekuensi 5,8 GHz 

𝑟 Jari-jari antena 85 mm 

𝜃 Sudut beamsquint 71° 

𝑑1 Ketebalan cavity 8 mm 

𝑑2 Ketebalan radiating element 0,1 mm 

𝑑 Ketebalan background 0,1 mm 

𝜀𝑟1 Permitivitas cavity 2,33 

𝑙 Panjang slot 0,5𝜆g 

𝑤 Lebar slot 1 mm 

 

Tabel 3.2 Parameter desain feeder RLSA ¼ lingkaran 

Simbol Parameter Nilai 

ℎ Tinggi silinder  3 mm 

𝑟𝑎 Jari-jari silinder 1,4 mm 

𝑏1 Gap udara bawah 4 mm 

𝑏2 Gap udara atas 1 mm 
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Gambar 3.2 Parameter tanpa penutup tembaga meliputi koefisien refleksi, bandwidth dan 

gain 

3.6 Merancang dan Mensimulasikan Antena RLSA ¼ Lingkaran 

Antena RLSA ¼ lingkaran dirancang menggunakan software VBA macros yang 

dibuat pada tesis Teddy Purnamirza [27] sehingga perancangan cepat dan efisien.  

 

 

Gambar 3.3 Merancang antena RLSA 

 

Kemudian untuk memotong antena RLSA menjadi ¼ lingkaran dibutuhkan software 

VBA macros dan memasukkan sudut putar 45° serta memasukan kembali nilai parameter 

inputan yang sama dengan nilai parameter inputan pada gambar 3.3 ke gambar 3.4. 

 

Gambar 3.4 Memotong antena RLSA ¼ lingkaran 

3.7 Skenario Penelitian  

Kebocoran daya pada antena RLSA ¼ lingkaran ini penulis mendapatkan 4 skenario 

yang cocok untuk digunakan. Tembaga yang digunakan menggunakan tebal yang sama 

dengan bagian radiating dan background yaitu 1 mm. 4 skenario ini melakukan simulasi 



 

III-6 

 

dengan panjang penutup tembaga kelipatan 3 mm dan digunakan untuk mengetahui 

perbedaan nilai gain, bandwidth dan S1,1 dibandingkan dengan antena RLSA ¼ lingkaran 

tanpa penambahan penutup tembaga. 

 

 

Gambar 3.5 Sampel alasan menggunakan kelipatan 3 

 

Dapat dilihat pada gambar 3.5 jika disimulasikan dengan kelipatan 1 mm, maka nilai 

S1,1 tidak berbeda jauh dibandingkan dengan kelipatan 3 pada contoh diatas P = 43 mm lalu 

mensimulasikan lagi pada P = 46 mm. 

3.7.1 Skenario I 

 

(a)                                      (b)                           (c) 

Gambar 3.6 Sampel skenario I pada (a) P = 1 mm, (b) P = 43 mm dan (c) P = 85 mm 
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Skenario I adalah penambahan penutup tembaga dari jauh ke dekat feeder dengan 

panjang penutup tembaga dari 1 mm sampai 85 mm dengan mensimulasikan beberapa 

parameterisasi panjang tembaga menggunakan kelipatan 3, jadi skenario ini akan 

mensimulasikan 29 parameterisasi dimulai dari panjang penutup tembaga 1 mm, 4 mm, 7 

mm, 10 mm, 13 mm, 16 mm, 19 mm, 22 mm, 25 mm, 28 mm, 31 mm, 34 mm, 37 mm, 40 

mm, 43 mm, 46 mm, 49 mm, 52 mm, 55 mm, 58 mm, 61 mm, 64 mm, 67 mm, 70 mm, 73 

mm, 76 mm, 79 mm, 82 mm dan 85 mm. Bila dapat nilai yang bagus kemungkinan akan 

disimulasikan kembali menggunakan nilai panjang penutup tembaga berdasarkan interval 

pada kelipatan 3 mm. 

3.7.2 Skenario II 

  

(a)                                               (b)                           (c) 

Gambar 3.7 Sampel skenario II pada (a) P = 1 mm, (b) P = 40 mm dan (c) P = 82 mm 

 

Skenario II adalah penambahan penutup tembaga dari tengah ke samping kiri dan 

kanan pada bidang potong antena RLSA ¼ lingkaran. Berdasarkan penjelasan sebelumnya 

skenario ini menggunakan kelipatan 3 mm, sehingga skenario ini mensimulasikan 

penambahan penutup tembaga 1,5 mm ke kiri dan 1,5 mm ke kanan dari 1mm sampai 82 

mm karena 85 mm sama dengan skenario 1 jadi tidak perlu disimulasikan di skenario II. 

Jadi skenario ini akan mensimulasikan 28 parameterisasi dimulai dari panjang penutup 

tembaga 1 mm, 4 mm, 7 mm, 10 mm, 13 mm, 16 mm, 19 mm, 22 mm, 25 mm, 28 mm, 31 

mm, 34 mm, 37 mm, 40 mm, 43 mm, 46 mm, 49 mm, 52 mm, 55 mm, 58 mm, 61 mm, 64 

mm, 67 mm, 70 mm, 73 mm, 76 mm, 79 mm dan 82 mm. Bila dapat nilai yang bagus 
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kemungkinan akan disimulasikan kembali menggunakan nilai panjang penutup tembaga 

berdasarkan interval pada kelipatan 3 mm. 

3.7.3 Skenario III 

  

            (a)                                     (b)                          (c) 

Gambar 3.8 Sampel skenario III pada (a) P = 1 mm, (b) P = 34 mm dan (c) P = 67 mm 

 

Skenario ketiga adalah penambahan penutup tembaga dari dekat feeder menjauhi 

feeder, tetapi dimulai dengan jarak 15 mm karena bila disimulasikan dari dekat feeder maka 

akan tidak bagus hasil performansinya. Jarak 15m didapat dari rumus berikut [29]:  

𝜆 (𝑙𝑎𝑚𝑏𝑑𝑎) =  
𝑐

𝑓
 (2.14) 

𝜆 (𝑙𝑎𝑚𝑏𝑑𝑎) =  
𝑐

𝑓
=  

3 x 10^8 m/s

5,800.000.000  𝐻𝑧
=  

3

58
= 51,72 𝑚𝑚  

  
𝜆

4
= 12,93 𝑚𝑚 + 2,07 untuk penyesuaian  

= 15 𝑚𝑚 

maka skenario ini melakukan penambahan penutup tembaga dengan panjang 

penutup tembaga 1mm sampai 67 mm, karena 70 mm sama dengan skenario 1 jadi tidak 

perlu disimulasikan di skenario III.  

Jadi skenario ini akan mensimulasikan 23 parameterisasi dimulai dari panjang penutup 

tembaga 1 mm, 4 mm, 7 mm, 10 mm, 13 mm, 16 mm, 19 mm, 22 mm, 25 mm, 28 mm, 31 

mm, 34 mm, 37 mm, 40 mm, 43 mm, 46 mm, 49 mm, 52 mm, 55 mm, 58 mm, 61 mm, 64 
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mm dan 67 mm. Bila dapat nilai yang bagus kemungkinan akan disimulasikan kembali 

menggunakan nilai panjang penutup tembaga berdasarkan interval pada kelipatan 3 mm. 

3.7.4 Skenario IV 

 

(a)                                                  (b) 

Gambar 3.9 Sampel skenario IV pada (a) P = 2,6 mm dan (b) P = 28,4 mm 

 

Skenario keempat adalah penambahan cavity dengan tebal 𝜆/4, dimana 𝜆 = c/f [29] dengan 

tembaga di area feeder. 

𝜆 (𝑙𝑎𝑚𝑏𝑑𝑎) =  
𝑐

𝑓
 (2.14) 

𝜆 (𝑙𝑎𝑚𝑏𝑑𝑎) =  
𝑐

𝑓
=  

3 x 10^8 m/s

5,800.000.000  𝐻𝑧
=  

3

58
= 51,72 𝑚𝑚  

  
𝜆

4
= 12,93 𝑚𝑚 

Jadi tebal cavity adalah 12,93 mm, dengan panjang penutup tembaga yang akan 

disimulasikan yaitu 0,1 𝜆 atau 2,6 mm, 0,3 𝜆 atau 7,8 mm, 0,6 𝜆 atau 15,5 mm, 0,9 𝜆 atau 

23,3 mm, dan 1,1 𝜆 atau 18,4 mm untuk meminimalisir kebocoran daya pada dekat feeder. 

 

3.8 Data tanpa penutup tembaga dan penambahan penutup tembaga  

Hasil-hasil simulasi yang telah dilakukan pada software CST Studio Suite 2018 

berdasarkan 4 skenario akan di inputkan pada microsoft excel. Diawali dengan melihat 
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anomali pada S1,1, kemudian melihat data bandwidth dan S1,1 pada tabel, seperti tabel 

dibawah ini:  

 

Tabel 3.3 Cara analisis data 

Panjang penutup tembaga 

(mm) 

Rentang 

Bandwidth (GHz) 

Bandwidth 

(GHz) 
S1,1 (dB) 

0 11,73 1,232 -23,69 

Sesuai skenario pada BAB 3.7 

      

      

      

 

 Setelah itu melihat anomali gain pada grafik. Diteruskan dengan melihat hasil 

perancangan terbaik pada setiap skenario dan lampiran A untuk melihat bagaimana cara 

merancang serta lampiran B hasil semua data parameterisasi.
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BAB V 

PENUTUP 

 

5.1 Kesimpulan 

Kebocoran daya pada bidang potong antena RLSA ¼ lingkaran menyebabkan nilai 

performansi gain, bandwidth dan S1,1 menurun, oleh karena itu menambah penutup 

tembaga pada bidang potong antena RLSA ¼ lingkaran menjadi solusi untuk melihat 

pengaruhnya, dengan jari-jari 85 mm dan menggunakan 4 skenario, hasil analisis 

penambahan penutup tembaga yaitu: 

1. Penutupan tembaga yang bisa memberikan performansi yang baik berada pada letak 

posisi tembaga 0 – 7 mm diukur dari tepi lingkaran dengan nilai gain 11,80 dB dan 

pada posisi tembaga 38 – 47 mm diukur dari tepi lingkaran dengan nilai gain 11,91 

dB, jadi ketika dikombinasikan pada posisi letak tembaga tersebut mendapatkan nilai 

gain 12 dB menguat 0,27 dB, bandwidth 1,279 GHz dan S1,1 -26,11 dB. 

2. Pada skenario III dan skenario IV tidak ada yang mendapatkan nilai gain lebih tinggi 

dari antena RLSA ¼ lingkaran tanpa penutup tembaga sehingga membuktikan bahwa 

panjang penutup tembaga yang mendekati feeder memiliki performansi yang tidak 

baik. 

5.2 Saran 

Untuk penelitian selanjutnya pada antena RLSA ½ lingkaran, antena RLSA 1/3 

lingkaran atau pemotongan yang lainnya, direkomendasikan untuk menambahkan penutup 

tembaga kombinasi pada skenario I dan II yang telah dilakukan pada penelitian ini. 

Penelitian ini juga diharapkan bisa menjadi prototype, dengan analisis perbandingan hasil 

simulasi dan pengukuran.
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LAMPIRAN A 

MERANCANG MODEL PENAMBAHAN PENUTUP TEMBAGA 

PADA BIDANG POTONG ANTENA RADIAL LINE SLOT  

ARRAY ¼ LINGKARAN  

 

 Pada lampiran A ini, menjelaskan bagaimana proses perancangan antena Radial Line 

Slot Array ¼ lingkaran (link youtube: https://youtu.be/ue-jWtMAc7A) dengan merancang 

model penambahan penutup tembaga dari skenario I, skenario II, skenario III dan skenario 

IV menggunakan software CST Studio Suite 2018. Maka langkah-langkah yang dilakukan 

sebagai berikut: 

1. Instal software CST Studio Suite pada PC / Laptop, kemudian buka CST Studio Suite 

yang diletakkan pada menu Start, Taskbar, Desktop dll. 

 

Gambar A.1 Membuka software CST Studio Suite 2018 

 

2. Selanjutnya yang pertama pilih New Template, yang kedua pilih MW & RF & 

Optical, yang ketiga pilih Antennas dan yang keempat pilih Next. 

 

Gambar A.2 Tampilan awal untuk membuat antena pada CST Studio Suite 2018 

https://youtu.be/ue-jWtMAc7A


 

A-2 

 

3. Maka akan muncul tampilan seperti gambar A.3. selanjutnya pilih Planar (Patch, Slot, 

etc.), kemudian pilih Next.  

 

Gambar A.3 Membuka antena jenis planar  

 

4. Maka akan muncul tampilan seperti gambar A.4.  selanjutnya pilih Time Domain, 

kemudian pilih Next.  

 

Gambar A.4 Memilih time domain 
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5. Maka akan muncul tampilan seperti gambar A.5 yang memperlihatkan pemilihan Unit 

satuan yang akan digunakan. Pada proses ini klik Next karena Unit sudah sesuai. 

 

Gambar A.5 Memilih Unit satuan 

 

6. Maka akan muncul tampilan seperti gambar A.6. Isi pada Frequency Min dan 

Frequency Max rentang frekuensi yang dibutuhkan. Lalu klik Next. 

 

Gambar A.6 Menentukan frekuensi minimum dan frekuensi maximum 
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7. Maka akan muncul tampilan seperti gambar A.7. Pada proses ini klik Finish karena 

bagian ini adalah penyelesaian pada proses sebelumnya. 

 

Gambar A.7 Penyelesaian masuk CST Studio Suite 2018 

 

8. Maka akan muncul tampilan seperti gambar A.8. selanjutnya untuk membuat antena 

RLSA dibutuhkan VBA Macro Editor berupa file RLSA_untuk_5.8_GHz.mcs. Pilih 

Home > Macros > Open VBA Macro Editor > Open > Pilih software VBA (RLSA-

_untuk_5.8_GHz.mcs). 

 

Gambar A.8 Membuka software VBA (RLSA_untuk_5.8_GHz.mcs). 
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9. Maka akan muncul tampilan seperti gambar A.9. selanjutnya isi nilai parameter 

inputan sesuai spesifikasi yang dibutuhkan. Kemudian pilih Run.  

 

Gambar A.9 Membuat antena RLSA 

 

10. Maka akan muncul tampilan seperti gambar A.10. selanjutnya slot pada ring perlu 

disatukan menjadi satu program dengan cara pilih Components > ring > Modeling > 

Boolean > Add > ubah nama slot pada ring menjadi Slot 0.2.2. 

 

Gambar A.10 Slot pada ring menjadi satu program 
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11. Selanjutnya dibutuhkan VBA Macro Editor berupa file memotong_RLSA_untuk-

_5.8_GHz.mcs. Pilih Home > Macros > Open VBA Macro Editor > Open > Pilih 

software VBA (memotong_RLSA_untuk_5.8_GHz.mcs). kemudian isi sudut putar 

45° untuk membuat antena RLSA ¼ lingkaran, lalu isi nilai parameter inputan sama 

seperti parameter inputan saat membuat RLSA untuk 5.8 GHz, maka pilih Run. 

 

Gambar A.11 Membuat antena RLSA ¼ lingkaran  

 

12. Selanjutnya melubangi slot pada ring dengan cara pilih Component > Antenna > 

Radiating > Modeling > Boolean > Insert > Ring > Slot 0.2.2.  

 

Gambar A.12 Melubangi slot pada ring 
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13. Buat new file dengan cara pilih File > New and Recent > Antena_Planar_1 template 

sebelumnya > buat nama file > Copy > Paste.  

 

Gambar A.13 New file 

 

14. Selanjutnya rotate antena RLSA ¼ lingkaran dengan cara blok pada Component 

bagian Antenna, Feeder dan Ring lalu pilih Modeling > Transform > Rotate > 

Rotation angles (Z = 45) > Ok sehingga bidang potong sejajar dengan garis vertikal, 

ini berfungsi untuk menambah tembaga pada bidang potong antena RLSA ¼ 

Lingkaran.  

 

Gambar A.14 Rotate 45° antena RLSA ¼ lingkaran 
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15. Skenario I parameter panjang penutup tembaga kanan 

 

Gambar A.15 Parameter panjang penutup tembaga kanan skenario I 

 

 Pada skenario I ini diawali dengan menambah tembaga pada bidang potong bagian 

kanan pada antena RLSA ¼ lingkaran dengan cara blok pada Component bagian 

Antenna, Feeder dan Ring lalu pilih Modeling > Brick pada bagian Shapes > klik 

Esc isi Name, Xmin, Xmax, Ymin, Ymax, Zmin, Zmax, Component: dan Material: 

sesuai gambar A.14. kemudian klik Review > Ok. 

 

16. Skenario I parameter panjang penutup tembaga kiri 

 

Gambar A.16 Parameter panjang penutup tembaga kiri skenario I 
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 Menambah tembaga pada bidang potong bagian kiri pada antena RLSA ¼ lingkaran 

dengan cara yang sama dengan Lampiran A No. 14. Namun isi Name, Xmin, Xmax, 

Ymin, Ymax, Zmin, Zmax, Component: dan Material: pada Brick sesuai gambar 

A.15. kemudian klik Review > Ok. 

 

17. Selanjutnya mengembalikan rotate ke sebelumnya dengan cara yang sama dengan 

Lampiran A No. 14 yang berbeda adalah Rotation angles (Z = -45) > Ok. 

 

Gambar A.17 Rotate -45° antena RLSA ¼ lingkaran 

 

18. Skenario I Parameterisasi 

 

Gambar A.18 Cara parameterisasi panjang penutup tembaga 
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 Parameterisasi dengan mengetik angka panjang penutup tembaga dengan cara pilih 

 Expression ketik angka panjang penutup tembaga > klik F7 

 

19. Skenario II 

 

Gambar A.19 Parameter panjang penutup tembaga skenario II 

 

 Parameterisasi pada skenario II sama dengan cara penambahan penutup tembaga pada 

skenario I yaitu yang terdapat pada no. lampiran A.14 s/d lampiran A.18. Hal yang 

membedakan adalah isi dari Brick tembaga kanan, tembaga kiri dan isi dari 

Parameter List bagian Expression, bila nilai Expression 1 mm maka ditulis 

setengahnya yaitu 0,5 mm, dst. 

 

20. Skenario III 

Gambar A.20 Parameter panjang penutup tembaga skenario III 
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Parameterisasi pada skenario III sama dengan cara penambahan penutup tembaga pada 

skenario I dan skenario II yaitu yang terdapat pada no. lampiran A.14 s/d lampiran 

A.18. Hal yang membedakan adalah isi dari Brick tembaga kanan, tembaga kiri dan 

isi angka Parameter List bagian Expression, karena panjang penutup tembaga dimulai 

dari 15 mm ke jauh feeder, maka bila nilai Expression 4 mm maka ditulis 4, dst. 

 

21. Skenario IV 

 

Gambar A.21 Parameter panjang penutup tembaga skenario IV 

 

 Parameterisasi pada skenario IV sebagian sama dengan cara penambahan penutup 

 tembaga pada skenario I, II dan III yaitu yang terdapat pada no. lampiran A.14 

 s/d lampiran A.18. Hal yang membedakan adalah adanya penambahan kaviti 

 sebesar λ/4 yaitu 12,93 mm dari Feeder ke depan atau luar antena serta ditambah 

 lagi penutup tembaga. isi Brick dari kaviti kanan dan kaviti kiri sesuaikan bagian 

 samping dengan cara potong menggunakan Boolean > Insert dan gabungkan semua 

 kaviti menggunakan Boolean > Add. Selanjutnya isi Brick dari tembaga kanan dan 

 tembaga kiri kemudian gabungkan tembaga kanan dan tembaga kiri 

 menggunakan Boolean > Add lalu isi angka Parameter List bagian Expression, 

 karena panjang penutup tembaga dimulai dari 15 mm ke jauh feeder, bila nilai 

 Expression 4 mm maka ditulis 4, dst. 
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22. Untuk mensimulasikannya pertama pilik Modeling > Pick > Pick points, Edges or 

Faces arahkan pada Feeder klik 2 kali sehingga membentuk seperti lingkaran 

berwarna merah. 

 

Gambar A.22 Pick points, edges or faces 

 

23. Selanjutnya pilih Simulation > Waveguide port > Name 1 > Ok 

 

Gambar A.23 Waveguide port 
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24. Selanjutnya pilih Simulation > Field Monitor > Farfield / RCS > Ok 

 

Gambar A.24 Field monitor 

 

25. Untuk memulai simulasi pilih Home > Start Simulation 

 

Gambar A.25 Start simulation 
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LAMPIRAN B 

DATA HASIL LENGKAP SKENARIO I, II, III DAN IV 

BERDASARKAN GAIN, BAMDWIDTH DAN S1,1 

 

Pada gain, bandwidth dan S1,1 angka yang menggunakan text highlight color adalah 

nilai yang lebih baik dari antena RLSA ¼ lingkaran tanpa penutup tembaga. 

 

Tabel B.1 Data lengkap pada skenario I  

Panjang 

tembaga (mm) 

Realized 

Gain (dB) 

Besar 

penguatan* 
Bandwidth (GHz) S1,1 (dB) 

0 11,73  - 1,233 -23,69 

1 11,65 -0,08 1,214 -23,8 

4 11,4 -0,33 1,219 -25,5 

5 11,47 -0,26 1,222 -26,99 

6 11,75 0,02 1,220 -25,44 

7 11,80 0,07 1,215 -24,76 

8 11,79 0,06 1,219 -24,13 

9 11,78 0,05 1,220 -24,08 

10 11,74 0,01 1,220 -24,08 

11 11,53 -0,2 1,216 -23,71 

12 11,55 -0,18 1,214 -23,57 

13 11,57 -0,16 1,213 -23,55 

16 11,59 -0,14 1,22 -23,6 

19 11,58 -0,15 1,22 -24,1 

22 11,48 -0,25 1,219 -25,71 

25 11,39 -0,34 1,218 -21,63 

28 11,15 -0,58 1,215 -22,08 

31 10,9 -0,83 1,222 -23,61 

34 10,64 -1,09 1,256 -18,75 

37 10,8 -0,93 1,255 -20,7 

40 10,88 -0,85 1,244 -20,83 

43 10,84 -0,89 1,234 -21,68 

46 9,52 -2,21 1,219 -25,48 

49 11 -0,73 1,229 -42,2 

52 10,56 -1,17 1,263 -24,65 

55 10,3 -1,43 1,29 -20,52 

58 10,54 -1,19 1,028 -10,1 

61 10,79 -0,94 1,067 -10,89 

64 10,92 -0,81 - -11,22 

67 10,79 -0,94 - -11,85 



 

B-2 

 

Tabel B.1 Data lengkap pada skenario I (Lanjutan) 

70 9,76 -1,97 - -6,34 

73 8,15 -3,58 - -5,18 

76 6,05 -5,68 - -5,48 

79 3,82 -7,91 - -6,31 

82 1,17 -10,56 - -2,79 

85 -13,47 -25,2 - -0,12 

 

Tabel B.2 Data lengkap pada skenario II 

Panjang 

tembaga (mm) 

Realized 

Gain (dB) 

Besar 

penguatan* 
Bandwidth (GHz) S1,1 (dB) 

0 11,73  - 1,233 -23,69 

1 8,19 -3,54 1,302 -12,43 

4 8,86 -2,87 1,281 13,07 

7 9,8 -1,93 1,28 -17,8 

8 11,89 0,16 1,292 -21,97 

9 11,91 0,18 1,296 -24,23 

10 11,89 0,16 1,289 -27,19 

11 11,84 0,11 1,288 -30,56 

12 11,77 0,04 1,282 -34,95 

13 11,68 -0,05 1,278 -40,65 

16 11,34 -0,39 1,275 -28,59 

19 11,04 -0,69 1,294 -24,21 

22 10,82 -0,91 1,315 -22,08 

25 10,69 -1,04 1,289 -20,51 

28 10,66 -1,07 1,348 -17,38 

31 10,54 -1,19 1,038 -10,15 

34 10,65 -1,08 1,047 -10,56 

37 10,76 -0,97 1,077 -10,89 

40 10,82 -0,91 1,143 -11,1 

43 10,93 -0,8 - -11,2 

46 10,88 -0,85 - -11,24 

49 10,77 -0,96 - -11,78 

52 9,64 -2,09 - -9,9 

55 9,65 -2,08 - -6,33 

58 8,83 -2,9 - -5,57 

61 7,9 -3,83 - -5,24 

64 6,85 -4,88 - -5,22 

67 6,04 -5,69 - -5,48 

70 4,92 -6,81 - -6 

73 3,73 -8 - -6,31 

76 2,21 -9,52 - -5,35 

79 -0,1 -11,83 - -2,77 
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Tabel B.2 Data penguatan dan penurunan performansi pada skenario II (Lanjutan) 

82 -6,12 -17,85 - -0,56 

 

Tabel B.3 Data lengkap pada skenario III 

Panjang 

tembaga (mm) 

Realized 

Gain (dB) 

Besar 

penguatan* 
Bandwidth (GHz) S1,1 (dB) 

0 11,73 - 1,233 -23,69 

1 11,33 -0,4 0,475 -13,96 

4 10,55 -1,18 - -5,3 

7 11,02 -0,71 - -573 

10 10,89 -0,84 - -5,93 

13 10,52 -1,21 - -5,87 

16 10,69 -1,04 - -6,53 

19 10,4 -1,33 - -6,42 

22 10,18 -1,55 - -6,28 

25 10,23 -1,5 - -6,34 

28 10,34 -1,39 - -6,1 

31 10,33 -1,4 - -6,16 

34 10,32 -1,41 - -6,16 

37 10,13 -1,6 - -6,2 

40 9,8 -1,93 - -6,31 

43 9,72 -2,01 - -6,33 

46 9,67 -2,06 - -6,33 

49 9,83 -1,9 - -6,27 

52 9,7 -2,03 - -6,34 

55 9,65 -2,08 - -6,33 

58 9,65 -2,08 - -6,34 

61 9,77 -1,96 - -6,33 

64 9,8 -1,93 - -6,35 

67 9,79 -1,94 - -6,34 

 

Tabel B.4 Data lengkap pada skenario IV 

Panjang 

tembaga (mm) 

Realized 

Gain (dB) 

Besar 

penguatan* 
Bandwidth (GHz) S1,1 (dB) 

0 11,73 - 1,233 -23,69 

0,1 λ atau 2,6 11,39 -0,34 1,399 -27,67 

0,3 λ atau 7,8 11,36 -0,37 1,438 -27,17 

0,6 λ atau 15,5  11,39 -0,34 1,439 -23,85 

0,9 λ atau 23,3  11,46 -0,27 1,347 -21,01 

1,1 λ atau 28,4  11,37 -0,36 1,285 -20,07 
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Tabel B.5 Data kombinasi skenario I dan II penutup tembaga terbaik 

Panjang 

tembaga (mm) 

Realized 

Gain (dB) 

Besar 

penguatan* 
Bandwidth (GHz) S1,1 (dB) 

0 11,73 - 1,233 -23,69 

SI 7 dan SII 9 12 0,27 1,279 -26,11 

 

*Selisih atau besarnya penguatan dibandingkan dengan dengan gain panjang tembang 0 mm 

atau tanpa penutup tembaga. 
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